
 

 

 

 

 

 

 

 

 

 

                
 

 

  

Mosul - 

Tariq Khalid 

Northern Technical University 

Engineering Technical College 

                     Mosul - Iraq 

Computer Aided Design  



AutoCAD 2010 3D                                                                                                                                    Tariq Khalid 

1 
 

 

 

 

 

 

 

 

 

 

 

by 

 

 

 

 

 

Northern Technical University 

Engineering Technical College 

 

 

Mosul-Iraq 



AutoCAD 2010 3D                                                                                                                                    Tariq Khalid 

2 
 

CAD: The acronym1 stands for2 Computer-Aided Drafting, Computer-Aided Design, or 

both, depending on whom you talk to. 
 
Initial Setup 

Easily tailor4 the AutoCAD environment to meet your needs using Initial Setup, which 

is displayed the first time you launch AutoCAD. With Initial Setup you can choose your 

industry as well as workspace and drawing template5 preferences6. The choices you make in 

the Initial Setup affect the default settings of various AutoCAD functionality7. 
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Menu Bar: The Menu Bar8 provides access9 to all AutoCAD commands. It consists of: 

File, Edit, View, Insert, Format, Tools, Draw, Dimension, Modify, Window, Help, Express, 

and Parametric*. 

                                                          Menu Bar 

 
 

How to show the Menu Bar 
Click on the down-arrow10 in the Quick Access bar11 brings down 

a pop-up list. Then select Show Menu Bar to display the AutoCAD Menu Bar.  

 

      

 

AutoCAD Work Spaces 

A workspace is a collection of menus, palettes, toolbars, 

and ribbons tailored for specific tasks, such as 3D modeling or 2D 

drafting.* 

There are three work spaces in AutoCAD 2010: 

1- 2D Drafting and Annotation,  

2- 3D Modeling,  

3- AutoCAD Classic. 

The workspaces are accessible12 from the status bar and docked13 at the lower right 

corner of the screen.                                                                 

   workspaces 

How to call workspaces 

The work space can be called and changed by: 

1-Right-click any toolbar and pick the toolbar. 

2- From Menu bar      Tools      work spaces   

3- Docked at the Status bar (lower left corner of screen). 
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Sheet size 
Most industries use a small range of standard sheet sizes. Three common sets of sizes 

exist, as shown in Figure 1-1 and Table 1-1: 

1- ANSI (American National Standards Institute) 

2- Architectural 

3- ISO (International Organization for Standardization) 

 
Relationships among standard paper sizes. 

 
 

Common Plot Sheet Sizes 

  

    Sheet Size                              Dimensions                     Comment 

 

   ANSI E                                        34 x 44" 

   ANSI D                                        22 x 34"                        E sheet folded in half 

   ANSI C                                        17 x 22"                        D sheet folded in half 

   ANSI B                                        11 x 17"                        C sheet folded in half 

   ANSI A                                       81⁄2 x 11"                      B sheet folded in half 

  

 Architectural Large E                    36 x 48" 

  Architectural E                             30 x 42" 

  Architectural D                             24 x 36"            Large E sheet folded in half 

  Architectural C                             18 x 24"                       D sheet folded in half 

  Architectural B                             12 x 18"                       C sheet folded in half 

  Architectural A                             9 x 12"                         B sheet folded in half 

  

  ISO A0                                         841 x 1189 mm          = 1 m2
 

  ISO A1                                         594 x 841 mm           A0 sheet folded in half 

  ISO A2                                         420 x 594 mm           A1 sheet folded in half 

  ISO A3                                         297 x 420 mm           A2 sheet folded in half 

  ISO A4                                         210 x 297 mm           A3 sheet folded in half 

 

You select a particular set of sheet sizes based on the common practices in your 

industry. You then narrow down your choice based on the area required by what you’re 

going to draw. For example, most imperial-units architectural plans are plotted on 

Architectural D- or E-size sheets, and most metric architectural plans go on ISO A1 or A0 

sheets. 
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ISO Sheet 
The A3 sheet has been chosen to  show the relation between the Length Y and the 

Width X. 

 
Y= X√2

2
 

Y= 297√2
2

 = 420 

 

A template: is simply a drawing whose name ends in the letters dwt, which you use as the 

starting point for another drawing. When you create a new drawing from a template, 

AutoCAD makes a copy of the template file and opens the copy in a new drawing editor 

window. The first time you save the file, you’re prompted for a new filename to save to; the 

original template file stays unchanged. Using a suitable template can save your time and 

worry because many of the setup options are already set correctly for you. You know the 

drawing will print correctly. 

AutoCAD creates a new, blank drawing with the settings in acad.dwt or acadiso.dwt. 

acad.dwt is AutoCAD’s default, drawing template for drawings in imperial units (that is, 

units expressed in inches and/ or feet). acadiso.dwt is the corresponding drawing template for 

drawings created in metric units. 

  

Drawing Units Setup 
 Every object we construct in an AutoCAD system is 

measured in units. We should determine the system of units 

within the AutoCAD system before creating the first 

geometric entities. 

1. In the Menu Bar select: 

Format ➪ Units 

2. Click on the Length Type option to display the different 

types of length units available. Confirm the length type is 

set to Decimal. 
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3. On your own, examine the other 

settings that are available. 

4. In the Drawing Units dialog box, set the 

Length Type to Decimal.  

This will set the measurement to the 

default S.I units, millimeter. 

5. Set the Precision to two digits after the 

decimal point as shown in the above 

figure. 

6. Pick OK to exit the Drawing Units 

dialog box.  

 

 

Drawing Area Setup 
Next, we will set up the Drawing Limits by entering a command in the command 

prompt area. Setting the Drawing Limits controls the extents of the display of the grid. It also 

serves as a visual reference that marks the working area. It can also be used to prevent 

construction outside the grid limits and as a plot option that defines an area to be 

plotted/printed. Note that this setting does not limit the region for geometry construction. 

1. In the Menu Bar select: 

Format ➪   Drawing Limits 

2. in the command prompt area, the message “Reset Model 

Space Limits: Specify lower left corner or [On/Off] 

<0.00, 0.00>:” is displayed. Press the ENTER key once to accept the default coordinates 

<0.00, 0.00>. 

 
 

 

3. In command area, the message “Specify upper right corner 

<420,297>:” is displayed. Press the ENTER key again to accept the default coordinates 

<420,297>. 

 

 

Millimeter 

r 
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4. On your own, move the graphic cursor15 near the upper-right comer inside the drawing 

area and note that the drawing area is unchanged. (The Drawing Limits command is used to 

set the drawing area, but the display will not be adjusted until a display command is used.) 

5. Inside the Menu Bar area select: 

View ➪   Zoom ➪ All 

The Zoom All command will adjust the display so that all objects in the drawing are 

displayed to be as large as possible. If no objects are constructed, the Drawing Limits are 

used to adjust the current viewport. 

6. Move the graphic cursor near the upper-right corner inside the drawing area and note that 

the display area is updated. 

Second method to set the drawing area (Short Method) 

1. Choose File ➪ New. 

Then, Template dialog box appears. 

2. Choose acadiso.dwt if you’re working in metric, or acad.dwt, if you’re working in 

imperial units. Then click OK. 

3. Write in the command lines: Z (This is the abbreviation of zoom). 

4. Respond to choices and write: A (the abbreviation of All). 

 

Buttons on Status Bar 
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To make your own template 
After you set all the requirements (unit, paper size. Etc.) .You can make your own 

template by  

File ➪ save as   and open the template (you will find no file there)  

In the file of type get the AutoCAD Drawing Template (*.dwt) 

Write a name to your file then O.K. 

 

AutoCAD Tool bars 

In order to get any tool bar                    

1-Tools ➪ Toolbars ➪   AutoCAD 

2- At any toolbar > right-click on it and select the required toolbar 

 

To show the toolbars in AutoCAD 2010 if there is no any toolbar existed and your AutoCAD 

version doesn’t show the toolbars command within the tools tab in the ribbon.   

Solution: 

At command lines, Write: -toolbar then: draw (or any tool bar you want)  

Then: Show or s 

The draw toolbar will be displayed. Then you can get any other toolbar by right click the 

existing tool bar and get the desired toolbar   

 

How to open AutoCAD with a specific template 

You can launch AutoCAD with a specific template of your choice. You do this with 

a command line switch. 

When you double-click the icon on your desktop or start AutoCAD from the Start menu, you 

are executing a statement. You can 

customize this statement by adding 

parameters, also called switches. 

To learn the statement of your desktop 

icon, right-click the AutoCAD icon and 

choose Properties. On the Shortcut tab, 

look in the Target text box. This is also 

where you add a switch. For example, 

the statement might look like this: 

“C:\Program Files\Autodesk\AutoCAD 2010\acad.exe” 
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To add a switch:  insert a space after the end of the statement and add a forward slash 

(/), then the switch you want. (AutoCAD has a number of switches, not just for templates.) 

In most cases you also add a descriptor. 

For a template named tariq1, you would add /t tariq. The statement for template would then 

look like this: 

“C:\Program Files\Autodesk\AutoCAD 2010\acad.exe”  /t tariq1 

Add:  space+ /t+space+ tariq1 

Note: You need to add quotation15 marks around any path or name (such as the template 

name) that contains spaces. 

It is recommended to duplicate the existing shortcut. When you use this method, you can 

create different shortcuts for different templates. To change the command line switch, follow 

these steps: 

1. Right-click the shortcut and choose Copy. 

2. Right-click the desktop and choose Paste. You’ll either get a new shortcut with 

“Copy” appended to the name or a dialog box that gives you the option to keep both 

the original and the copy with a number appended to the name. You can change the 

name of the shortcut to reflect the name of the template it will open. 

3. Right-click the shortcut copy and choose Properties. 

4. On the Shortcut tab, in the Target text box (not the Start In box), move the cursor to 

the end of the existing statement. 

5. Press the spacebar to add a space, then type /t and another space. Finally add the name 

of the template. Be sure to add quotation marks around the template name if it 

contains spaces. 

6. Click OK. 

Defining Positions 
In AutoCAD, there are five methods for specifying the locations of points when we 

create planar geometric entities.* 

1- Interactive method: Use the cursor to select on the screen. 

 

2- Absolute coordinates (Format: X,Y): Type the X and Y coordinates to locate the point on 

the current coordinate system relative to the origin. (for example, 7,4). 

 

3- Relative rectangular coordinates (Format: @X,Y): Type the X and Y coordinates 

relative to the last point. (For example, @3,2) 

 

4- Relative polar coordinates (Format: @Distance<angle): Type a distance and angle 

relative to the last point. (For example, @6<45) 

 

5- Direct Distance entry technique: Specify a second point by first moving the cursor to 

indicate direction and then entering a distance. 
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To show command lines   [Tools     

command lines, or Ctrl+9] 

 

To change the color of the 

drawing area 

1- Menu bar: Tools ➪ option,   the 

Options dialogue box will appear as in Fig. 

2- Click Display then the color button and 

choose the color. 

 

 

 

To Display the scroll bar in the drawing window 

1- Menu: Tools ➪ option, the Options dialogue box will appear as in Fig. 

above and click Display then Display scroll bars in drawing window. 

Visual Styles 
Five default Visual Styles are available. 

1• 2D Wireframe: Displays the objects using lines and curves to represent 

the boundaries of objects created. Line types and line weights are visible 

with this option. 

Note that this is the default AutoCAD display mode. 

2• 3D Hidden: Displays the objects using the 3D wireframe representation 

with lines that are located behind surfaces and solids removed. 

3• 3D Wireframe: Displays the objects using lines and curves to represent 

the boundaries of objects created. Displays a shaded 3D user coordinate 

system (UCS) icon. Note that linotypes and line weights are not visible 

with this option. 

4• Conceptual Visual Style: Creates a shaded image of polygon faces and 

solids that uses the Gooch face style, a transition between cool and warm 

colors rather than dark to light. The effect is less realistic, but it can make 

the details of the model easier to see. 

5• Realistic Visual Style: Creates a shaded image of polygon faces and solids that gives the 

objects a smooth and realistic appearance. 
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To add or remove tabs or panels from ribbon 
 Right-click on a clear space on the ribbon. 

Tick any square in front of that tab to add or remove the tick to remove the tab 

Differences between Isometric and 3D solid drawings 

3D solid is a 3D drawing (i.e. x, y, and z coordinates). While Isometric is 2D drawing 

(i.e. x and y coordinates only). 

 

    View Cube: ViewCube is a 3D navigation tool that is displayed when you are 

working in a 3D visual style. With ViewCube, you can switch between standard and 

isometric views. 

 

Click on the left to show the left side of your object. Click on the home icon to show 

isometric view. 

To call the View Cube 

Ribbon: View tab ➪ Views panel ➪View Cube 

 Menu:  View ➪  Display ➪ ViewCube : On 

  Command entry: navvcube 

 

3D Primitives 
A primitive solid is a ‘building block' that you can use to work with in 3D. Rather than 

extruding or revolving an object, AutoCAD has some basic 3D shape commands at your 

disposal. From these basic primitives, you can start building your 3D models. In many cases, 

you get the same result from drawing circles and rectangles and then extruding them, but 

doing it one command is generally faster. Using these with Boolean operations can be a very 

effective way of drawing in 3D. There are eight different primitives that you can choose 

from and are on the Home > Modeling Tool Panel (when in the 3D workspace). 
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SHAPE  COMMAND  ICON  DESCRIPTION  

BOX BOX 
 

Creates a solid box after you provide 2 
opposite corners and a height.  

SPHERE SPHERE 
 

Creates a solid sphere from a center 
point and radius.  

CYLINDER CYLINDER 
 

Creates a straight cylinder from a center 
point, radius and height.  

CONE CONE 
 

Creates a tapered cone from a center 
point, radius and height.  

WEDGE WEDGE 
 

Creates a triangular wedge from 2 
opposite points.  

TORUS TORUS 
 

Creates a torus (donut shape) based on 
center point, radius and tube radius.  

PYRAMID 
PYRAMID / 

PYR 
 

Draws a solid object with a polygon (3-
32 sides) base that rises to a central 
point. 

POLYSOLID PSOLID 
 

Draws a solid object with width and 
height as you would draw a polyline.  

You can use primitives to either begin building a model, or it can even be a finished 

object on its own. Many of these commands are similar to 2D commands, except with an 

extra coordinate in the Z axis. Here is a summary of working with these commands. 

 There are four Access Methods for any 3D primitive, taking Box as an example 

 

1- Ribbon: Home tab ➤ modeling panel ➤ Box 

2- Menu: Draw ➤ Modeling ➤ Box 

3-Toolbar: Modeling 

4- Command entry: box  

       Region       

Converts an object that encloses an area into a region area 

The methods to call region: 

1- Toolbar: Draw ➪region 

2- Command entry: region 

3- Menu: Draw ➪region 

4- Ribbon ➪ Home ➪ Draw 

http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#box
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#sphere
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#cylinder
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#cone
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#wedge
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#torus
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#pyramid
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#psolid
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If you draw a 2d enclosed lines using the command line, when these lines extruded, it 

will be converted to surfaces, while using region ( or boundary) for these lines, then the 

extrude, will turn them to  a 3d object. 

         Region is a command that applied at any closed 2d object to convert it to a region 

which can be extruded after that to make a 3d object. Extruding 2d without region will result 

a surface. 

     Extrude       

Extrude: To transform 2D objects to 3D 

objects 

 

Can be called by: 

1- Toolbar: Modeling 

2- Ribbon➪ Home➪ Extrude 

3- Menu: Draw➪ Modeling    

4- Command entry: Extrude 

Revolve      
To revolve a 2d object around an axis 

Example 1: 

 

                                              

Example2: How to make a glass 
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Example3:  List the shortest steps (commands and their details) to draw the fluid coupling 

end cap shown in figure below in AutoCAD 2010.  
                                         

Solution: 

1- File➪ New➪ acadiso➪ Z ➪ A 

2- Front view 

3- Draw Fig. A 

4- Boundary  

5- Revolve the two polylines, the angle 180 

6- Subtract 

7- Southeast Isometric view 

 

 

 
Revolve can be used with 3d by holding 

Ctrl button and select a face   

 

 

 

 

                                   

UCS 
UCS stands for user coordinates system, 

While 

WCS stands for World coordinates system. 

How to call UCS 

1- Ribbon: View tab ➤ Coordinates panel ➤ UCS 

2- Menu: Tools ➤ New UCS ➤ UCS 
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3- Toolbar: UCS 

4- Command entry: UCS 

 

There are two toolbars of UCS    UCS and UCSII                                                       

 

  UCS II 

 

 

Viewports 

How to call Viewports Dialog Box 

 
Ribbon: View tab ➤ Viewports panel ➤ Named Viewports 

Menu: View ➤ Viewports 

Toolbar: Layouts 

Command entry: vports 

How to set the viewports 

 
To make three view on the screen: 

View ➪Viewports ➪New viewports (or 3 viewports). A dialogue box appears 

.choose Three: Left   or any type of view. 

 

 

Fillet        To round the edge of any two connected surfaces of the 3d object 
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Chamfer                 

 

SWEEP   

Creates a 3D solid or surface by sweeping a 2D object along a path. 

Access Methods 
1-Ribbon: Home tab ➤ Modeling panel ➤ Sweep 

2-Toolbar: Modeling 

3-Menu: Draw ➤ Modeling ➤ Sweep 

4-Command entry: sweep 

 

Summary 

With the SWEEP command, you can create a new solid or surface by sweeping an 

open or closed planar curve (profile) along an open or closed 2D or 3D path. SWEEP draws 

a solid or surface in the shape of the specified profile along the specified path. You can 

sweep more than one object, but they all must lie on the same plane. 

When you select an object to sweep, it is automatically aligned to the object that is used as 

the path. 

Example1:  Sweep➤ (scale) 
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  List the shortest steps (commands and their details) to draw the tea pot tube shown in 

figure below in AutoCAD 2008.  

                                           
Solution: 

1- File- New- acadiso- Z – A 

2- Front view 

3- Draw two ellipses and pick the polyline (choose Arc) and start from lower point to draw 

first figure 

4- Sweep and choose the two ellipses and the path is the arc 

5- Subtract the inner swept ellipse from the outer one 

6- Slice the lip 

 
 

 

List the shortest steps to draw the object in Fig. 1  

 
 

1- Draw a rectangle according to the cross-section of the object 

2- Draw a line represents the path or the length of the twisted part  

3- From dashboard choose Sweep and pick the rectangle then enter 

4- Write t (twist), then enter the value of the twisted angle 

5- Pick the left side then draw a circle and make presspull 

6- Union 
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Helix      

 
The methods to call Helix 
1- Menu: Draw ➪Helix 

2- Ribbon ➪Draw ➪ Hilux 

3- Command line: helix 

4- Tool bar: modeling 

 

Example: The shortest steps to make a spring from a 8mm dimeter wire  in AutoCad 2008 

 

1- Draw a 8mm dia. circle using the command circle 

2- Draw a helical using the command helix 

3- Sweep the circle on the helix 

 
 

LOFT    

Creates a 3D solid or surface in the space between several cross sections. 

Access Methods 
Ribbon: Home tab ➤ Modeling panel ➤ Loft 

Menu: Draw ➤ Modeling ➤ Loft 

Toolbar: Modeling 

Command entry: loft 

The cross sections can be either open or closed 2D objects such as circles, arcs, 

or splines. 
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SOLIDEDITING 
Edits faces and edges of 3D solid objects. 

 

Access Methods 
 

Ribbon: Home tab ➤ Solid Editing panel  

Menu: Modify ➤ Solid Editing 

Menu: Tools ➤Toolbars ➤Solid Editing Toolbar  

Command entry: solidedit 

 

Summary 

The SOLIDEDIT command provides many ways to modify the 

edge and face sub objects of 3D solid objects. You can extrude, move, 

rotate, offset, taper, copy, delete, and assign colors and materials to 

faces. You can also copy and assign colors to edges. You can imprint, 

separate, shell, and clean. 

You cannot use SOLIDEDIT with mesh objects. However, if you 

select a closed mesh object, you will be prompted to convert it to a 3D 

solid.  

                                
 

Union, Subtract, Intersect                                  

Union: to join At least 2 solids or coplanar regions  

The methods to call the following tools in AutoCAD 2010 

1- Toolbar: Modeling 

2-Toolbar: Solid Editing 

3- Menu: Modify ➪ Solid Editing  

4- Command entry: Union, Subtract, Intersect 

5- Ribbon: Solid Editing 
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Subtract:  to subtract an object from other  

 

Intersect to make an object from the interference of two objects 

 

Move faces 

 

       Shell                                                  
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State the differences between Offset Faces and Extrude Faces. 

Ans. There is no taper for Offset faces 

 

How to change the color of one face for an object. 
Ans. Menu: Modify: Solid editing –Color faces 

 

What are the differences between the following commands?  

1- Extrude faces and Offset faces.   

 

Ans. 

Extrude faces has taper while Offset faces doesn't have 

2- Extrude and Extrude faces. 

 Ans. 

 Extrude is used for 2D drawing while Extrude faces is used for faces in 3D solids. 

3- Extrude and sweep.  

Ans. 

Extrude can be used without path 

Extrude cannot be done when the 2D drawing and the path are at the same plane 

State the tool and its details- if needed- for the following changes: 
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Answer: 

A- Extrude, or presspull .  B- Move faces, C- presspull, D- Rotate faces, E- Slice,  

F- Extrude faces- taper negative angle 

     State the tool and its details- if needed- for the following changes: 

A)  1- Slice (by choosing an axis that slices the body to two objects 70*50*60 and keep both 

objects). 

2- Slice  ( by choosing  3 points then press enter and choose the three points that give the 

inclined  plane , then keep one object of the slice). 

 

3D Operations 

Menu: Modify ➤ 3D Operations 

 

SLICE   
Creates new 3D solids and surfaces by slicing, or dividing, 

existing objects. 

 

Access Methods  
 

Ribbon: Home tab ➤ Solid Editing panel ➤ Slice 

Menu: Modify ➤ 3D Operations ➤ Slice 

Command entry: slice 

 

Summary 

The cutting plane is defined with 2 or 3 points, by specifying a major plane of the 

UCS, or by selecting a surface object (but not a mesh). Either one or both sides of the sliced 

3D solids can be retained. 

 



AutoCAD 2010 3D                                                                                                                                    Tariq Khalid 

23 
 

Convert to solid  

1-Draw a circle or rectangle. 

2- Open properties. 

3- Select the circle (or rectangle), so you can see it properties. 

4- Change the thickness from 0 to any number like 20. 

5- The circle will get a thickness. 

6- Pick Convert to solid, so the circle becomes a solid. 

 

Convert to Surface 

The same steps from Convert to solid, so the circle becomes a surface. 

 

Surfaces 

      There are at least five methods to make surfaces    
1- Write in the command line 3d   then choose any primitive surface you want. 

2- Write in the command ai_dish   or any shape (dome pyramid torus….) 

3- Draw a line then from 3d make in the dashboard pick extrude and pick the line (any 

object made by line without region or boundary, when extruded, It will turn to a surface). 

4- Draw any 2D object using line command then pick properties pick the drawing. The 

properties window defines the object as line.  In front of thickness, change the number 0 

to any other number like 4. The object will be extruded. But still a line. 

From 3d make choose ➪ convert to surface and pick the object. It will turn to surface. 

5- Draw ➪ Modeling➪ Meshes 

 

How to do the following activities 

Change the color of an object. 

Ans. 

Properties➪ in front of color pick the desired color 

------------------------------------------------------------------------------------------------ 

Enforce lines to be drawn just horizontally and vertically. 

Ans. Activate the ORTHO button on the Status bar 
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----------------------------------------------------------------------------------------------- 

Make three view on the screen 

View ➪ Viewports ➪ New viewports (or 3 viewports). A dialogue box appears. 

Choose 3 viewports. 

---------------------------------------------------------------------------------------------- 

Measure the Area and Perimeter of an irregular 2D enclosed shape in AutoCAD2010. 

Ans.      Tools➪ Inquiry ➪Area   then pick the ends of the shape lines 

-------------------------------------------------------------------------------------- 

Display the scroll bar in the drawing window. 

Ans.  Menu: Tools ➪ option,  ,  the Options dialogue box will appear as in Fig. 

above and click Display then Display scroll bars in drawing window  

---------------------------------------------------------------------------------------------- 

Change the color of one face for an object. 

Ans.       Menu: Modify: Solid editing ➪Color faces 

------------------------------------------------------------------------------------------------ 

Moving a hole in an object to a new place. 

Ans. 

Menu: Modify: Solid editing ➪Move faces 

---------------------------------------------------------------------------------------------- 

1. Enables you to draw at any face of an object directly. 

Ans. Activate the ORTHO button on the Status bar 
 

How to draw in Word Microsoft program using AutoCAD program 

While you are in word program pick  

Insert ➪Object… 

Then choose AutoCAD program 

A new page of AutoCAD program opens 

Draw your drawing, then  

File➪ update Microsoft Word 

Now return to Word.  Your drawing will be there. 

Another method is to draw the required drawing in AutoCAD, then Edit➪ Copy (0r 

Copy with base point), then select the drawing, and open the Word Program and Paste 
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Explain the function of the following: 

 
    1- ORTHO     2- Union     3- delobj     4- Flatshot     5- DUCS     6- Intersect       7- pedit   

   8- Properties    9- Mocoro     10- Clean Screen   11- Area    12- oops 

  Ans. 

1- ORTHO: To enforce lines to be drawn just horizontal and vertical 

2- Union: To join two objects and make them one object 

3- Delobj In order to maintain or erase the original object after some operations like   

Extrude, Revolve. 

Set delobj to 0 will deactivate its function, hence the original object will remain. 

Set delobj to 1 will activate its function, hence the original object will be erased. 

4- Flatshot: create 2D geometries from a 3D model using its different views on 

XY plane in model space (to make projection view for a 3d object) 
 

5- DUCS Enable you to draw at any face of an object directly. 

 

6- Intersect: to form a shape by connecting to object. The connection zone is the result of 

the Intersect 

 

 7- Pedit: To convert any number of lines to one polylines orTo edit a polyline or to change a 

line or lines to a polyline.       

 8- Properties: To identify and change any object in the drawing area. 

 

9- Mocoro:  this command contains four operations: 
 

 
10 - Clean Screen: To hide all tool bars in order to increase the space of drawing 

11- Area: To measure the area and perimeter of any 2d object 
 
12- Oops: To restore a deleted object without erasing the objects that done after the 
delete operation. 
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How to show the Ribbon on the drawing area of AutoCAD 2010 in case 

it is not existed.   

Solution: 

1- Menu ➪ Tools ➪ Pallete ➪ Ribbon 

2- Write down at command lines : _ribbon 
                                                                                                           

  

How to make a Template file.  

File➪ save as: go to C: Program files➪ autocad2008 ➪ Template: 

In the File of Type: choose AutoCAD Drawing Template (*.dwt) 

 

 

List at least 8 button (Status toggles) in status bar  

Answer: 

 
 

 How to show the Ortho button in Status bar if it is not existed in 

AutoCAD2010 
 

Answer: click the black arrow head at the lower right corner of screen (called Application 

Status Bar Menu). Then click the Status Toggles to show the shortcut menu. Tick the square 

in front of Ortho 

 

How to lock a docked toolbar 
Ans. Open the lock in the lower right corner and then tick the square in front of Docked 

toolbars 
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Materials 
Applying materials to objects 

From Menu: Tools ➪ Palettes ➪ Tool palettes, then select the object and click the required 

material to attach the object. 

 

 

Calculation methods in AutoCAD 2010 
 

1- Write in the command line     :  

2- Write in the command line  

3- Write in the command line: quickcalc 

  A calculator is shown. 

4-Press (ctrl+8) to show the calculator. 

5- Standard toolbar ➪ quickcalc 

6- Right-click and choose quickcalc. 

7- Menu ➪Tools➪ palettes ➪ quickcalc. 

8- Ribbon ➪ View tab ➪ Palettes ➪ quickcalc. 

 

 

Write down (and draw for every changing state) the steps to draw the following 3D object in 

AutoCAD2010. 

 

1- File—ACADISO 

2- Z--- A 

3- At Front view , Draw the following 
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4- Isometric View 

5- Presspull A  by 20  (or region the whole object then Extrude) 

6- Presspull B by 30   (or region the whole object then Extrude) 

7- Presspull C by 20   (or region the whole object then Extrude) 

8- Presspull D by 30   (or region the whole object then Extrude) 

                  

 

B)  Presspull 

 

State the tool and its details- if needed- for the following changes:  
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A- Visual styles-- Visual styles Manager—Edge Settings—Edge mode—change the edge 

mode from isolines to none 

B- Presspull 

C- Loft 

D- Shell 

E- Revolve 

F- Sweep- (scale) 

G- Convert to solid 

H- Revsurf 

J- Presspull 

K- Delete faces 

 

State the tool (or tools) and its details- if needed- for the following changes: (note: shortest 

methods are required) 

H 
G 



AutoCAD 2010 3D                                                                                                                                    Tariq Khalid 

31 
 

             

 

              

     

Answer:                                                                

A- 1- Slice the object from the middle to make two equal and similar objects. 

     2- Slice again one object as in fig below (or Taper faces) 

 

B- Interference checking 

C- Move faces or Offset faces 

D- Move faces 

E- Presspull 

 

 

E 

C D 

 

A B 
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State the tool (or tools) and its details- if needed- for the following changes:  

                

                      

           

 

 

 

Answer: 

A- Array- polar ,         B- Fillet ,       C- Presspull ,  D-1- Slice   2-Slice   3- Union 

E- 1-Slice  2- Slice the front part  3- Union 

 

            Example: 

                         Fig. 1                             Fig. 2                          Fig. 3 

A 

D 
C 

B 

E 
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4- In the 3D Navigate panel pick the southeast isometric view, 

5- Visual Styles pick 3D Hidden Fig. 2.  

6- Activate the Dynamic UCS (DUCS), Draw the circle and the triangle Fig. 3.                                           

  

        Fig. 4                                           Fig. 5 

 7- Boundary for the triangle 

8- presspull the circle and the triangle. Fig. 4. 

9- Union the two solids to get the solid Fig. 5 

       

Write all the commands that you need with details, to draw the figure shown below (Confirm 

your answer with necessary sketches for each step). 
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1- Choose left side view and select line or polyline to draw the following Fig. 

 

2- Boundary and pick the inside point 

3- Extrude With height 34 to get Fig. below 

 

3- Locate 3 points by using line or point tools 

4- Slice and choose 3points (in default) and press enter 

then pick the three points in order to get the following Fig. 

 

5- Activate the DUCS Button & go to the horizontal upper 

face and draw the base of the second object then use the 

Region tool and pick the lines to create a region ( the 

polyline can be used). 

6- Extrude the region to height 7 

7 – In Visual Styles pick 3D Hidden. 

8- In 3D Navigate Pick Southeast Isometric. The object 

will be as in Fig. below: 

    

        

 B- List all the shortest steps to draw- with sketches - the object in Figure below. (Note: 

Approximate any dimension) 
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Solution: 

1-File- New- acadiso- Z – A 

2- Choose Top view 

3- Draw the 2D as in fig. A  

4-Menu: draw- boundary 

4- Revolve the rectangle 360 degree, and the object 270 

degree 

5-from the 3D Navigate in the Dashboard, pick Southeast 

Isometric fig. B 

6- Subtract, Fig. C 

 

        
 

 

Write down the steps (with sketches for each step) to draw the following 3D solid shown in 

figure below (note: the 3D solid is one part). 

 

                         
 

   Solution:   

1-File- New- acadiso- Z – A 

2- Choose Top view 

3- Draw the 2D as in fig. A  

4-from the 3D Navigate in the Dashboard, pick Southeast Isometric 
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5- Presspull as in fig. B 

6-Slice from the center of the hole and keep both sides 

7- Slice the front part and choose 3 points as in Fig. D 

8- Union as in Fig. E 

 
 

 

Write down the steps (with sketches for each step) to draw the following 3D solid shown in 

figure below 

 

 
 

Solution: 

1-File- New- acadiso- Z – A 

2- Choose Front view  

3- Pick from draw toolbar the polyline and circle then trim tool and draw the figure A 

 
 

4- The 3D Navigate in the Dashboard, pick Southeast Isometric 

5-Extrude depth 36, Fig. B 

6-Slice and choose yz plane, Fig. C 
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7-choose the front object and activate DUCS and ORTHO buttons, draw lines 18, 13, and 

line 15 

8- Slice this object by choosing 3points, Fig. D 

9- Slice by 3 points the first part, Fig. E 

10- Slice by 3 points the second part, Fig. F 

11- Union Fig. G 

 

 
 
 

 

 

List the steps (with sketches) to draw the following figure in AutoCAD 2008:  

(Note: approximate any dimension).  

 
Solution: 

                             

1-File- New- acadiso- Z – A 

2- Choose Southeast Isometric View 

3- From 3D Make in Dashboard pick Box as in Fig. A 
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4- Menu: Modify- Solid Editing- Shell 

    And choose the top and front surface to be removed Fig. B 

5-Slice-3points as in Fig. C 

6-draw on the lower surface the rectangle and the four circles as in Fig. D 

7- Presspull the rectangle and the four circles. 

 
 

 

 

 

  

 

 

 

 

 List the steps (with sketches for each step) to draw the following figure in AutoCAD 2010: 

 

                                                        
 Solution: 

1-File- New- acadiso- Z – A 

2- draw Fig. A 
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3- Boundary and pick points in the three objects 

4- Extrude the three objects to 36 depth 

5- Slice after defining the 3 points 

6- Union 

 
 

 

                         

Write down the steps with sketches to draw the following figure (approximate any 

dimension). 

                                       
Solution: 

                     1- File- New- acadiso- Z – A 

2- Front view 

3- Polyline: draw fig. A 

4- Extrude: Depth 97, and change to Southeast Isometric Fig. B 

5- Circle Fig. C 

6- Extrude circle 

7- Change to Bottom View and Mirror the Shaft two times.  Fig. F 

9- Change to 3D Wireframe to see the covered shaft and subtract the four shafts from the 

object. Fig. G 

10- Circle R=28. Fig. G 

11- Extrude the circle 97. Fig. H 

12- Draw a line connecting  
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List the shortest steps (with sketches) to draw the following figure  

] 
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Solution: 

     1- File- New- acadiso- Z – A 

2- Southeast Isometric View 

3- From 3D Make in Dashboard pick Box and choose cube with length 35, Fig. A 

4-two lines 10. And one line 15, to specify point for slice 

5- Slice and choose XY plane and pick the end of line 10. Fig. B 

6- Slice and choose 3Points. Pick the end of line 15 with the corner. Fig. C 

7- Slice and choose 3Points. Pick the end of line 10. Fig. D 

8- Union 

To apply dimensions transfer the UCS to the plane that is measured 

 

 

 

 
 

 

How to draw freehand 
1. At the Command prompt, enter sketch. 

2. Press Enter again to accept the last saved type, increment, and tolerance values. 

3. Move cursor in the drawing area to begin sketching. 

As you move the pointing device, freehand line segments of the specified length are drawn. 

During the command, freehand lines are displayed in a different color. 

4. Click to suspend sketching. 

You can click a new start point to resume drawing from the new cursor location. 

5. Press Enter to complete the sketch. 

An alternate method: 

1. At the Command prompt, enter sketch. 
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2. Click and hold to begin sketching and move your cursor. Release to suspend 

sketching. 

3. Repeat the previous step as needed. 

4. Press Enter to complete the sketch. 

Note: SKETCH does not accept coordinate input. 

 

 

Flatshot: This command can create 2D geometries from a 3D model using its different 

views on XY plane in model space 

 
 

 

Export: 
To transfer the object to photo with extension bmp  

File- Export… 

Then choose a name for the photo and from files of type pick bitmap(*.bmp) 

Then pick the objects you want to be in 

the photo 

 

Menu:  View  Motion Path 

Animations...At the Command prompt, 

enter anipath.  

 Command entry: anipath 

Specifies settings for a motion path 

animation and creates an animation file. 
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Camera 

Link Camera To  

Links a camera to a static point or a motion path in a drawing.  

Point  

Links a camera to a static point in a drawing.  

Path  

Links a camera to a motion path in the drawing. 

Pick Point/Select Path  

Selects either the point where a camera is located or the path along which a camera travels, 

depending on whether Point or Path was selected. 

Point/Path List  

Displays a list of named points or paths to which you can link a camera. To create a path, 

you can link a camera to a line, arc, elliptical arc, circle, polyline, 3D polyline, or spline.  

Note When you create a motion path, a camera is automatically created. If you delete an 

object that you specified as a motion path, the named motion path is also deleted. 

Target 

Link Target To  

Links a target to a point or a path. 

If the camera is linked to a point, the target must be linked to a path. If the camera is linked 

to a path, you can link the target to either a point or a path. 

Point  

If the camera is linked to a path, links the target to a static point in the drawing.  

Path  

Links the target to a motion path in the drawing. 

Pick Point/Select Path  

Selects either the point or a path for the target, depending on whether Point or Path was 

selected. 

Point/Path List  

Displays a list of named points or paths to which you can link the target. To create a path, 

you can link a target to a line, arc, elliptical arc, circle, polyline, 3D polyline, or spline.  

Animation Settings 

Controls the output of the animation file.  

Frame Rate (FPS)  

The speed at which the animation will run, measured in frames per second. Specify a value 

from 1 to 60. The default value is 30. 

Number of Frames  

Specifies the total number of frames in the animation. 

With the frame rate, this value determines the length of the animation. When you change this 

number, the Duration value is automatically recalculated. 

Duration (seconds)  

Specifies the duration (in sections) of the animation. 

When you change this number, the Number of Frames value is automatically recalculated. 

Visual Style  

Displays a list of visual styles and render presets that you can apply to an animation file. See 

VISUALSTYLES and RENDERPRESETS for more information.  

ms-its:ACAD_ACR.chm::/VISUALSTYLES.htm
ms-its:ACAD_ACR.chm::/RENDERPRESETS.htm
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Format  

Specifies the file format for the animation. 

You can save an animation to an AVI, MOV, MPG, or WMV file format for future 

playback. The MOV format is available only if Apple QuickTime Player is installed. The 

WMV format is available and is the default selection only if Microsoft Windows Media 

Player 9 or later is installed. Otherwise, AVI is the default selection.  

Resolution  

Defines the width and height of the resulting animation in screen display units. The default 

value is 320 x 240. 

Corner Deceleration  

Moves a camera at a slower rate as it turns a corner. 

Reverse  

Reverses the direction of an animation. 

When Previewing Show Camera Preview  

Enables the display of the Animation Preview dialog box so you can preview the animation 

before you save it. 

 

 

 

 

How to find the Azimuth and Altitude of Mosul 
 

In order to calculate the sun angles (Azimuth 

and Altitude)  

Right-click on any tool bar and get the Lights 

toolbar 

Pick Geographic Location … 

1- Enter the location Values 

2- Use Map… (Or enter the location value) 

3- Pick from region: Africa 

4- Erase the tick in front Nearest Big City 

5- By mouse choose Mosul region 

6- Accept updated time zone 

And close the window 

 

Return to Lights toolbar and get Sun 

Properties 

1- Pull down the scroll bar and choose Sun 

angle Calculator 

2- Change the time and date to the required one, then the Azimuth and Altitude will be 

changed to the exact values. 
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Dimensioning 

To change the color of Extension lines. 

Ans. 

From Dimensions tools bar pick Dimension Style. A dialogue box appears. Pick Modify 

➪Under the Lines gate ➪ Extension lines. Then change the box in front the word color 

from by block to the desire color. 

-------------------------------------------------------------------------------------------- 

     



AutoCAD 2010 3D                                                                                                                                    Tariq Khalid 

45 
 

 To change the color of Dimension lines. 

Ans. 

From Dimensions tools bar pick Dimension Style. A dialogue box appears.  

Pick Modify ➪Under the Lines gate ➪ Dimension lines. Then change the box in front the 

word color from by block to the desire color. 

 

 

 

Dimensioning For 3D solid 
 

1- Use the UCS tool bar with each face you want to apply dimensions 

2- Extension lines must be at xy-plane 

3- Text direction is with the positive portion of y-axis 

 

 
 

 

 

Dimensioning for Isometric 
 

1- Make the cross-hairs suitable for each surface dimensioning (by Ctrl+E or F5) 

2- Apply the dimensions  

3- To fix each dimension pick (Dimension Edit) from dimensions tool bar or write at the 

command lines (_dimedit) as below 

Command: _dimedit 

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: o 
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Select objects: 1 found 

Select objects: 

Enter oblique angle (press ENTER for none): -30 
 

 

 

     1- File- New- acadiso- Z – A 

1- Rectangle 

2- Lines to divide the rectangle to three portions 

3- South- east isometric 

4- Presspull 

5- Slice- three points 

6- conceptual 
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1- File- New- acadiso- Z – A 

2- SE Isometric 

3- Rectangle 

4- Presspull 

5- slice  
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Ex: 
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Appendix A 

يوفر  -9شريط القوائم   -8      وظيفة -7      تفضيلات -6قالب      -5    يفصل -4     واجهة المستخدم -3يرمز ل  او موقوف ل     -2الاختصار    -1

  منسدلة -14مثبتة، راسية      -13     ن الوصول له  او قابل الوصول له يمك  -12     شريط الوصول السريع     -11السهم النازل     -11     الوصول

                       مؤشر -15  

فضاء العمل: هو مجموعة من القوائم، اللوحات، شرائط الادوات، شرائط، ولوحات المعلومات المفصلة من اجل مهمات 

 معينة مثل النمذجة ثلاثية الابعاد او الرسم ببعدين.
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List at least ten items at the Menu bar 

List and Explain briefly the methods for specifying the locations of points in AutoCAD 

Define the Following: 

Worksapace 

List the default workspaces in AutoCAD 

List at least three methods to call workspaces 

What does the acronym ISO stands for?. Classify its drawing sheets with their sizes 

What is the relation between the length and width of the ISO drawing sheets 

List the default Visual Styles in AutoCAD 

Write down at least seven buttons on the status bar 

List at least four methods for specifying the locations of points. And give an example for 

each one 

State how to change the color of the drawing area 

State How to Display the scroll bar in the drawing window 

List the default Visual Styles in AutoCAD 2010 

State how to show command lines   

List at least two methods to show any toolbar 

Explain the role of the command region in extrude 

 

 


